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Section 1 Product overview

Hydrolab operating software is a Windows application for the capture and display of
sensor measurements from supported water monitoring instruments. Hydrolab operating
software also supplies system status, sensor calibration and firmware update information
for supported instruments.

• System status—alerts, battery level (if applicable) and log status (active or
completed)

• Sensor calibration—reminders, history, checks and step-by-step instructions
• Firmware update—available updates

Measurements are shown in real time in tabular and/or graph format. The measurement
interval, parameters and measurement units shown are selected by the user. Real-time
measurements can be manually captured and saved to log files on a PC.
For long-term (unattended) monitoring, measurements are saved to a log that is
configured by the user. Measurements are automatically completed and recorded to the
log on the supported instrument according to the selected measurement interval and date
range.
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Section 2 User interface and navigation

2.1 Device connection window
At startup, the device connection window shows.
On the left side of the window is a list of the log files that have been recently saved to the
PC. To open a log file, click the log file and then refer to Look at a log file on page 25.
Select an instrument in the Device Connection field, then click Connect to connect the
PC and instrument. If an instrument has an active alert, a status icon shows. Refer to 
Table 1.

Table 1  Status icons

Icon Description Status

Warning There is a problem that can affect instrument operation (e.g., a sensor calibration is necessary).

Critical There is a problem that it is necessary to correct before instrument deployment (e.g., a sensor failure
has occurred).

2.2 Status bar
The status bar at the top of the window shows the status of the instrument. Refer to 
Figure 1.
If there is a new version of the Hydrolab Operating Software available, a pop-up window
will open. Click Yes to install the software update.
Note: The available software and firmware updates are identified each time the PC is connected to
the internet.

Figure 1  Status bar

1   Instrument name (configurable) 5   Log status (active or completed). Click Logging for
details.

2   Serial number of the instrument 6   Type of communications module used. Click to see and/or
change the configuration setting for the communications
module.

3   Number and type (warning or critical) of active alerts1 7   Click to show the devices connected to the PC

4   Battery level2

1 Only shows when there is an active alert.
2 Only shows when the instrument has the internal battery pack option.

2.3 Navigation bar
Click the icons on the navigation bar to go to the different windows. Refer to Figure 2 and 
Table 2.

Figure 2  Navigation bar
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Table 2  Windows

Window Shows

Overview • Status of the instrument and sensors installed and any active alerts
• Last calibration date of each sensor installed and time until calibration expires, if applicable.
• Status of the last log made (start time, in progress or completed). Click Logging for details.
• A list of the completed logs kept on the instrument

Note: Logs cannot be opened from this window. Refer to Look at a log file on page 25.

Monitoring Real-time measurements in tabular and/or graph format. Refer to Look at real-time measurements on page 17.

Logging • Status of the last log made (start time, in progress or completed)
• A list of the completed logs kept on the instrument

Note: Logs cannot be opened from this window. Refer to Look at a log file on page 25.

Calibration Calibration information for each sensor—date and type of the last calibration, calibration interval and the date of
the next calibration, if applicable.

Sensors • Sensor settings and sensor information
• Calibration information for each sensor—date and type of the last calibration, calibration interval and the

date of the next calibration, if applicable.

Settings • Instrument information
• General settings—Instrument name, sound and date and time settings
• Firmware—The firmware versions installed and available firmware updates
• Security—The features that are password protected.
• External Dependencies—Environmental values entered to increase the accuracy of some measurements.

User interface and navigation
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Section 3 Configuration

3.1 Software settings
The software settings are configured on the menu bar and are saved on the PC. The
software settings are applied to all instruments connected to the PC.

3.1.1 Select the language and calibration mode

1. Select Edit>Preferences.
Note: The Preferences menu option cannot be selected when Calibration is selected on the
Navigation bar.

Note: Not all the parameters shown apply to the connected instrument.
2. Select the Language tab. Select the language.
3. Select the Calibration Mode tab. Select an option.

Option Description

Manual The user manually accepts the calibration measurement at the end of each step.

Auto The instrument automatically accepts the calibration measurement at the end of
each step after the measurement is stable.

4. Click OK to save the changes.
The device connection window shows.

5. Select the instrument, then click Connect.

3.1.2 Select the measurement units for calibration

1. Select Edit>Preferences. All the parameters that can be measured by the supported
instruments are shown.
Note: The Preferences menu option cannot be selected when Calibration is selected on the
Navigation bar.

Note: Not all the parameters shown apply to the connected instrument.
2. Select the measurement units shown during calibration and calibration checks.

Note: The selected measurement unit does not change what is recorded to log files. All
measurement units are recorded to log files.

3. Click OK to save the changes.
The device connection window shows.

4. Select the instrument, then click Connect.

3.1.3 Add or remove users, locations and offices
User, location and office information can be manually added to logs and log files. User
information can be manually added to calibrations and calibration check records.

• User—Name of a user
• Location—Name, description and GPS coordinates of a measurement location
• Office—Name and description of an office that collects measurements

Note: This software does not have user accounts. Login is necessary only to change features that
are password protected. Refer to Configure the security settings on page 9.

1. To add, change or remove a user:

a. Select Setup>Users. The list of users shows.
b. To add a user, click Add.
c. To edit or delete a user, select the user, then click Edit or Delete.

2. To add, change or remove a location:

a. Select Setup>Locations. The list of locations shows.
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b. To add a location, click Add.
Note: To add a location with the same values as an existing location, select a location and
click Copy to New.

c. To edit or delete a location, select the location, then click Edit or Delete.
3. To add, change or remove an office:

a. Select Setup>Offices. The list of offices shows.
b. To add an office, click Add.

Note: To add an office with the same values as an existing office, select an office and click
Copy to New.

c. To edit or delete an office, select the office, then click Edit or Delete.

3.1.4 Select the stability check settings
The stability check settings are used by the software to identify when measurements are
stable. The stability status of measurements (stable or unstable) shows on the Monitoring
window when Use Stability Check is selected.
Note: Stability check settings are not used for calibrations.

1. Select Setup>Stability Check.
2. Select the applicable tab (Real-time or Depth Profile).

Note: The parameters that are available on the connected instrument are black. The
parameters that are not available on the connected instrument are blue.

3. Select a checkbox to enable stability check for that parameter.
4. Select the stability check criteria for the parameter.

Option Description

Maximum Delta Select the maximum difference between the current measurement and the
average measurement for a measurement to be identified as stable.
For example, if the current measurement is 10 and the average
measurement is 15. The current measurement is identified as stable if the
maximum delta is 5 or more.

Number of
Samples

Select the number of measurements that are used to calculate the average
measurement used for stability checks.

5. Click Save.

3.1.5 Copy the software settings to another PC (optional)
Save the software settings (users, locations and offices) to a tab-separated value (.tsv)
text file, and then transfer the software settings to another PC for quick configuration.

1. Select Setup>Export Settings File.
2. Enter a filename, then click Save.
3. Copy the file to another PC with Hydrolab Operating Software.
4. On the other PC, open the Hydrolab Operating Software.
5. Select Setup>Import Settings File to import the software settings.

3.2 Instrument settings
The instrument settings are configured on the Settings window and are saved on the
instrument.
The model, serial number, firmware version, manufacture date and last service date of
the instrument are shown on the Settings window.

Configuration
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3.2.1 Configure the date, time and sounds
The date and time are recorded in measurement records and the calibration history. The
date and time are used to identify when sensor calibration or maintenance is necessary.

1. Click Settings in the navigation bar.
2. Optional: In the SONDE NAME field, enter a descriptive name for the instrument

(default = serial number of the instrument).
The name and serial number are used to identify the instrument in log files and show
on the status bar.

3. In the SOUNDS field, enable or disable sounds from the instrument (default =
enabled).
When enabled, the instrument makes sounds when it goes into low-power (sleep)
mode, when it comes on and one time every second while there is an active log.

4. In the SONDE DATE AND TIME field, set the correct date and time. Select the hour,
minute or second interval to change the value.
Note: To enter the date and time shown on the PC, click Sync with PC.

3.2.2 Install firmware updates
The Update Firmware button is on when firmware updates are available.

1. Click Settings in the navigation bar.
2. Click Firmware.

The firmware versions installed for the instrument and sensors show.
3. Click Update Firmware.
4. Select the firmware updates to install.
5. Click Install Selected. The selected firmware is installed.
6. When the firmware installation is complete, click OK.

Note: To uninstall a firmware update, get the previous firmware version from technical support.
Save the file to the PC, then click Revert firmware.

3.2.3 Configure the security settings
The features shown in Table 3 can be password protected to prevent unauthorized
changes. Table 3 shows the features that are password protected by default. There is
one security password.

1. Click Settings in the navigation bar.
2. Click Security. The features that are currently password protected are shown.
3. Click Edit.
4. Enter the password.

Note: The security password is set the first time the security settings are changed.
5. Select the features to be password protected.
6. Click Save.

Table 3  Features

Feature Defaults Prevents

Calibration Intervals Changes to the sensor calibration intervals

Calibration Type Changes to the selected calibration types

Firmware Update Changes to the firmware

Modify Log File • Changes to a log after it is made and before it has started
• The active log from being stopped

Configuration
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Table 3  Features (continued)

Feature Defaults Prevents

Maintenance Intervals Changes to the sensor maintenance intervals

Calibration Calibration

Delete Log File from Sonde X Removal of log files from the instrument

Sensor Settings X Changes to the sensor settings

Stability Check Changes to the stability check criteria or stability check setting (enabled or disabled)

3.2.4 Change the security password

1. Click Settings in the navigation bar.
2. Click Security. The features that are password protected show.
3. Click Edit.
4. Enter the security password.
5. Click Change Password.
6. Enter the new security password in each field, then cllck OK.
7. Click OK to close the window.

3.2.5 Enter the external dependencies
Enter the external dependencies (e.g., barometric pressure, altitude) of the measurement
location to increase the accuracy of some measurements, if applicable.

1. Click Settings in the navigation bar.
2. Click External Dependencies.
3. Enter the external dependencies of the measurement location in the applicable fields.

Enter the barometric pressure at sea level if applicable. Enter the altitude used for
depth measurements if applicable.
Note: NaN = not a number

3.3 Sensor settings
Configure the sensor settings before initial use and as necessary. The sensor settings are
configured on the Sensors window and are saved on the instrument.
Note: By default, login is necessary to change the sensor settings. Refer to Configure the security
settings on page 9.

3.3.1 Configure the sensor maintenance alerts
Enter the sensor maintenance intervals to get sensor maintenance alerts. A sensor
maintenance alert stays active until the date of last service is manually changed.

1. Click Sensors in the navigation bar.
2. Select a sensor to configure.

The model, serial number, firmware version and manufacture date of the sensor
show. The parameters and measurement units measured by the sensor show.

3. In the Maintenance area, enter the date of the last service and a maintenance interval
for the sensor.

3.3.2 Configure the sensor settings

1. Click Sensors in the navigation bar.
2. Select a sensor to configure.

Configuration
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The model, serial number, firmware version and manufacture date of the sensor
show. The parameters and measurement units measured by the sensor show.

3. For the turbidity sensor, to manually start a cleaning cycle, click Clean Now.
4. In the Settings area, select an option. Not all of the settings that follow apply to all the

sensors.

Option Description

Revolutions per
clean

Set the number of wiper revolutions per cleaning cycle. Options:
0 (disabled) to 10 (default = 1).
Note: One revolution is approximately 6 seconds. Make sure that the
cleaning cycle time is not more than the sensor warm-up time for
logging.

Measurements
Averaged

Select the number of measurements used to calculate the average
measurement (default = 10). For example, if measurements averaged is
set to 10, the value shown for measurement 10 will be the average of
the current measurement plus the 9 previous measurements. Set to 1 to
not do measurement averaging.

Compensation
method

Select the method for conductivity temperature compensation or select
None (no temperature compensation). Refer to the sections that follow.
Specific conductivity = conductivity × f(T), where f(T) is a function of
temperature (T) in °C.
To remove any temperature compensation, select None. Specific
conductivity: f(T) = 1 

3.3.2.1 Hydrolab fresh
Hydrolab fresh (default) is the temperature compensation method based on the
freshwater temperature compensation of the manufacturer.
f (T) = c1T5 + c2T4 + c3T3 + c4T2 + c5T + c6

Where:
c1 = 1.4326 × 10–9

c2 = –6.0716 × 10–8

c3 = –1.0665 × 10–5

c4 = 1.0943 × 10–3

c5 = –5.3091 × 10–2

c6 = 1.8199 

3.3.2.2 Hydrolab salt
Hydrolab salt is the temperature compensation method based on the saltwater
temperature compensation of the manufacturer.
f (T) = c1T7 + c2T6 + c3T5 + c4T4 + c5T3 + c6T2 + c7T + c8

Where:
c1 = 1.2813 × 10–11

c2 = –2.2129 × 10–9

c3 = 1.4771 × 10–7

c4 = –4.6475 × 10–6

c5 = 5.6170 × 10–5

c6 = 8.7699 × 10–4

c7 = –6.1736 × 10–2

c8 = 1.9524 

Configuration
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3.3.2.3 Standard Methods 2510
Std Methods 2510 is the temperature compensation method based on compensation
published in Standard Methods for the Examination of Water and Wastewater.
f(T) = 1 ÷ [1 + 0.0191 (T – 25)]

3.3.2.4 DIN EN 27888
DIN EN 27888 is the temperature compensation method based on DIN standard EN
27888.
f(T) = [(1 – a) + a × (ηΘ ÷ η25)n] × 1.116 
(ηΘ ÷ η25) = A + exp(B + (C ÷ (Θ + D)))
Where:
a = 0.962144 
η = the viscosity of the solution
Θ = temperature (°C) at which the measurement was made
n = 0.965078 
A = –0.198058 
B = –1.992186 
C = 231.17628 
D = 86.39123 

3.3.2.5 Custom
Custom is the temperature compensation method based on values that the user
identifies. The user identifies the values a, b, c, d, e, f, g and h.
f (T) = aT7 + bT6 + cT5 + dT4 + eT3 + fT2 + gT + h

3.4 Communications module settings
Configure the applicable communications module before initial use. The settings are
saved on the individual communications module.
Note: The USB communications module does not have any settings to configure.

The communications modules are optional accessories, with the exception of the USB
communications module that is supplied with the instrument. Only one communications
module can be connected to the instrument at one time.
The model, serial number, firmware version and manufacture date of the communications
module are shown on the communications module window.

3.4.1 Configure the SDI-12 communications module

1. Connect the USB connector of the SDI-12 communications module to the PC.
2. Start the Hydrolab Operating Software. The communications module shows in the

Connect to Device field.
3. Select the communications module, then click Connect. The configuration window for

the communications module shows.
4. In the Communications area, select the:

• Address for the instrument (0–9)
• Delay between data transmissions (0–999 seconds)

5. In the Parameter Order area, add the parameters to transmit to the data logger
(maximum of 10).

a. To add a parameter, click Add.
b. In the Parameter field, select the parameter to add.

Configuration
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c. In the Resolution field, set the resolution (number of significant digits) for the
parameter (1–9), then click OK.

6. To remove a parameter, select the parameter and click Delete.
7. Put the parameters in the order that they will be transmitted to the data logger. The

parameter at the top is transmitted first. To move a parameter up or down in the list,
select the parameter and click the UP and DOWN arrows.

8. Click Back to Sonde to go back to the instrument window.

3.4.2 Configure the RS232 or RS485 Modbus communications module

1. Connect the USB connector of the Modbus communications module to the PC.
2. Start the Hydrolab Operating Software. The communications module shows in the

Connect to Device field.
3. Select the communications module, then click Connect. The configuration window for

the communications module shows.
4. In the Communications area, select the:

• Address for the instrument (1–254)
• Baud rate (1200, 2400, 4800, 9600 or 19,200)
• Data bits (7 or 8)
• Stop bits (1 or 2)
• Parity (none, odd or even)

5. In the Parameter Order area, add the parameters to transmit to the data logger
(maximum of 10).

a. To add a parameter, click Add.
b. In the Parameter field, select the parameter to add.
c. In the Resolution field, set the resolution (number of significant digits) for the

parameter (1–9).
6. To remove a parameter, select the parameter and click Delete.
7. Put the parameters in the order that they will be transmitted. The parameter at the top

is transmitted first. To move a parameter up or down in the list, select the parameter
and click the UP and DOWN arrows.

8. Click Back to Sonde to go back to the instrument window.

3.4.3 Configure the RS232 TTY communications module

1. Connect the USB connector of the RS232 TTY communications module to the PC.
2. Start the Hydrolab Operating Software. The communications module shows in the

Connect to Device field.
3. Select the communications module, then click Connect. The configuration window for

the communications module shows.
4. In the Communications area, select the:

• Sample rate (1–3600 seconds)
• Baud rate
• Data bits (7 or 8)
• Stop bits (1 or 2)
• Parity (none, odd or even)
• Update interval (1–3600 seconds)
• Time Stamp format (e.g., HHMMSS or DDMMYYYYHHMMSS)

Configuration
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5. In the Parameter Order area, add the parameters to transmit to the data logger
(maximum of 10).

a. To add a parameter, click Add.
b. In the Parameter field, select the parameter to add.
c. In the Resolution field, set the resolution (number of significant digits) for the

parameter (1–9).
d. In the Field Width field, set the number of characters sent back for each

parameter (1–9), then click OK.
6. To remove a parameter, select the parameter and click Delete.
7. Put the parameters in the order that they will be transmitted. The parameter at the top

is transmitted first. To move a parameter up or down in the list, select the parameter
and click the UP and DOWN arrows.

8. Click Back to Sonde to go back to the instrument window.

Configuration
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Section 4 Calibration

4.1 Calibrate the sensors
Calibrate the sensors before initial use, at regular intervals and after sensor maintenance
or modifications.

1. Click Calibration in the navigation bar.
2. Select the sensor to calibrate.
3. When the External Dependencies field shows, make sure that the value in the field is

correct for the measurement location. External dependency (e.g., barometric
pressure) values are used in measurement and calibration calculations.
Note: NaN = not a number

4. Select the calibration type as necessary.
Note: Only one type of calibration can be used at a time. The previous calibration is lost when
a new calibration is done.

5. Click Start Calibration.
6. Complete the instructions shown for each step, then click Next to go to the next step.
7. When the calibration is complete:

a. In the Calibration Interval field, enter the time interval before the next calibration
is necessary. Calibration intervals are different for different types of sensors and
environmental conditions. Calibrate as necessary.

b. Optional: In the User ID field, select the user that did the calibration.
c. Optional: In the Log Note field, enter a note for the calibration.

8. Click Save Calibration.
9. If the calibration fails:

a. Click Cancel to not save a record of the calibration.
b. Click Redo Point to do the last measurement again.
c. Click Save to record the failed calibration. Select the user that did the calibration

and enter a note for the calibration (optional).

4.2 Do a sensor calibration check
A sensor calibration check is done between calibrations to identify if a sensor is still
calibrated. Adjust the calibration interval setting of the sensor as necessary based on the
results of the calibration check.
One calibration standard is measured during a calibration check. At the end of the check,
the software shows the actual (entered) value of the calibration standard and the
measured value of the calibration standard. Calculate the difference between the values
to identify if the sensor is still calibrated.

1. Click Calibration in the navigation bar.
2. Select the sensor.
3. When the External Dependencies field shows, make sure that the value in the field is

correct for the measurement location. External dependency (e.g., barometric
pressure) values are used in measurement and calibration calculations.

4. Click Check Calibration.
5. Complete the instructions shown for each step, then click Next to go to the next step.
6. When the difference between the values shown identifies that the sensor is not

calibrated, click Save and Recalibrate to record the calibration check.
Note: To not record the calibration check, click Cancel.

15



7. When the difference between the values shown identifies that the sensor is still
calibrated:

a. In the Calibration Interval field, enter the time interval before the next calibration
is necessary. Calibration intervals are different for different types of sensors and
environmental conditions. Calibrate as necessary.

b. In the User ID field, select the user that did the calibration check.
c. Optional: In the Log Note field, enter a note for the calibration check.

8. Click Save.

4.3 Look at the calibration history
The calibration history shows the sensor serial number and the date, time, calibration
type (if applicable), standard(s), slope, offset, user information and calibration notes for
each calibration done (completed or failed) and calibration check done.

1. Click Calibration in the navigation bar.
2. Select the sensor.
3. Click Calibration History. The calibration history for the selected sensor shows.
4. To show the calibrations for all the sensors, click All Sensors.
5. To save the current view of the calibration history to the PC as a comma-separated

value (.csv) text file, click Export.

Calibration
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Section 5 Operation

5.1 Monitoring
Monitoring is used for spot measuring with a deployment cable and a PC. All
measurements are done at the same time and are shown in real time. Real-time
measurements can be manually captured and saved to log files on a PC.

5.1.1 Real-time monitoring

5.1.1.1 Look at real-time measurements
Click Monitoring in the navigation bar. Real-time measurements show in tabular and/or
graph format. Refer to Figure 3. The parameters, measurement units and measurement
time interval shown are configurable.

Figure 3  Real-time window

Item Description

1 Click and pull a table column heading to change the column order.

2 Click the view icons to change the view. Options: Table only, graph only, table and graph

17



Item Description

3 Click View Options to change the:

• Measurement interval (1 second minimum)
• Parameters shown in the table and/or graph1

• Graph line color and/or Y-axis scale for a parameter
• Thickness (weight) of the lines in the graph

Click View Options to add or remove symbols (data points) or a grid from the graph.
Note: The view options settings do not change what is recorded to log files. All measurements are recorded to log files.

4 Click and pull the split pane divider to change the height of the table and graph.

5 Click to change the color for the parameter.

6 Put the cursor on a data point in the graph to see the time, date and measured value.

7 Click an option to change the time interval shown on the graph.

1 The NTU units shown are based on FNU measurement.

5.1.1.2 Capture and save real-time measurements
Capture real-time measurements individually or for a time interval, then save them to a
log file(s) on the PC. Optional: Record notes and user, location and office information in
the log files.
Note: The view options settings do not change what is recorded to log files. All measurements are
recorded to log files.

1. Click Monitoring in the navigation bar.
2. To show the stability status of real-time measurements (stable or unstable), select

Use Stability Check. A stability status icon shows. Measurements that are not stable
are highlighted in the table and are identified in log files.
Note: A measurement is identified as stable when it is within the selected stability criteria for
the parameter. To look at the stability check criteria, click Edit Criteria. Refer to Select the
stability check settings on page 8.

3. To capture the next measurement, click Manual. The next measurement is shown in
the right pane. Refer to Figure 4.

4. To capture measurements for a time interval, click Start and then Stop after the
necessary time interval. The captured measurements are shown in the right pane as
they occur. Refer to Figure 4.

5. To add a note(s) to the captured measurements, enter a note in the Notes field, then
click Add to Log. The note is shown in the right pane, above the last captured
measurement.

6. To save the captured measurements and notes (if added) shown in the right pane:

a. Click Save.
b. Select a folder on the PC, then enter a filename for the log file in the File Name

field.
c. Optional: In the User field, select a user.

Note: To add a new user, select New User in the User field.
d. Optional: In the Office field, select an office.

Note: To add a new office, select New Office in the Office field.
e. Optional: In the Location field, select a location.

Note: To add a new location, select New Location in the Location field.
f. Click Save.

After the captured measurements are saved to a log file, the log file can be looked at until
Clear All is clicked. Click View Log File. Refer to Look at a log file on page 25.

Operation
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Figure 4  Real-time window – right pane

Item Description

1 Click and pull a table column heading to change the column order.

2 Click and pull to resize the window.

3 Click and pull to see all the parameter measurements captured.

5.1.2 Depth profile monitoring
Use depth profile monitoring to capture and save measurements at selected depths.
Note: An instrument with the optional depth sensor is necessary to do depth profile monitoring.

5.1.2.1 Make a new depth profile
Select the settings for the depth profile.

1. Click Monitoring in the navigation bar.
2. Select the Depth Profile tab.
3. Select the depth profile settings.

Optional: In the Template field, select a saved depth profile template to use the
template settings.

Option Description

Surface
Measurement

Set the minimum measurement depth.

Depth Increment Set the depth increment between measurements.
For example, the depth increment is 10 m and the direction is top to
bottom, the first measurement is at the surface measurement depth, the
second measurement is at 10 m.
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Option Description

Bottom
Measurement

Set the maximum measurement depth.

Direction Top to Bottom—Measurements are done from the surface
measurement depth to the bottom measurement depth. Bottom to Top
—Measurements are done from the bottom measurement depth to the
surface measurement depth.

Use Stability
Check

When selected, a measurement is accepted after the measurement is
stable.
Note: A measurement is identified as stable when it is within the
selected stability criteria for the parameter. To look at the stability check
criteria, click Edit Criteria. Refer to Select the stability check settings
on page 8.

Capture Mode Auto—The instrument automatically accepts a measurement after the
measurement is stable. Manual—The user manually accepts a
measurement after the measurement is stable.
Note: This option is only available when Use Stability Check is
selected.

4. To save the selected settings to a template for use in the future, click Save as New.
Note: To delete a template, select Setup>Delete Templates.

5. Click Start Monitoring.

5.1.2.2 Look at depth profile measurements
Real-time measurements show in tabular format. Captured measurements show in graph
format and in the right pane. Refer to Figure 5. The parameters, measurement units and
measurement time interval shown are configurable.
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Figure 5  Depth profile window

Item Description

1 Click and pull a table column heading to change the column order.

2 Click the view icons to change the view. Options: Table only, graph only, table and graph

3 Click View Options to change the:

• Measurement interval (1 second minimum)
• Parameters shown in the table and/or graph
• Graph line color and/or Y-axis scale for a parameter
• Thickness (weight) of the lines in the graph

Click View Options to add or remove symbols (data points) or a grid from the graph.
Note: The view options settings do not change what is recorded to log files. All measurements are recorded to log files.

4 Put the cursor on a data point in the graph to see the time, date and measured value.

5 Click and pull the split pane divider to change the width of the table and graph.

6 Click to change the color for the parameter.

5.1.2.3 Capture and save depth profile measurements
Measurements occur when the instrument is at the depths selected in the depth profile
settings. When a measurement is completed, it is captured manually or automatically
based on the depth profile settings. In addition, real-time measurements can be manually
captured as necessary.
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Save the captured measurements to a log file(s) on the PC. Optional: Record notes and
user, location and office information in the log files.
Note: The view options settings do not change what is recorded to log files. All measurements are
recorded to log files.

1. Move the instrument to the depth shown on the screen.
When the instrument is at the specified depth, a measurement is done.

2. When the measurement is stable, the measurement is captured. Click Capture
Reading if Manual is selected in the depth profile.
The captured measurement shows on the graph and in the right pane. Refer to 
Figure 6.

3. Do steps 1–2 again until all the measurements in the depth profile are completed.
4. To manually capture a real-time measurement, click Manual Capture. The next

measurement is shown in the right pane and the graph.
5. To add a note(s) to the captured measurements, enter a note in the Notes field, then

click Add to Log. The note is shown in the right pane, above the last captured
measurement.

6. To show the stability status of the real-time measurements (stable or unstable), select
Use Stability Check. A stability status icon shows. Measurements that are not stable
are highlighted in the table and are identified in log files.
Note: A measurement is identified as stable when it is within the selected stability criteria for
the parameter. To look at the stability check criteria, click Edit Criteria. Refer to Select the
stability check settings on page 8.

7. To save the captured measurements and notes (if added) shown in the right pane:

a. Click Save.
b. Select a folder on the PC, then enter a filename for the log file in the File Name

field.
c. Optional: In the User field, select a user.

Note: To add a new user, select New User in the User field.
d. Optional: In the Office field, select an office.

Note: To add a new office, select New Office in the Office field.
e. Optional: In the Location field, select a location.

Note: To add a new location, select New Location in the Location field.
f. Click Save.

8. To do another depth profile, click New Profile.

After the captured measurements are saved to a log file, the log file can be looked at until
Clear All or New Profile is clicked. Click View Log File. Refer to Look at a log file
on page 25.
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Figure 6  Depth Profile window – right pane

Item Description

1 Click and pull a table column heading to change the column order.

2 Click and pull to resize the window.

3 Click and pull to see all the parameter measurements captured.

5.2 Logging
Logging is used for long-term (unattended) monitoring. Measurements are recorded to a
log that is configured by the user. Measurements are automatically completed and
recorded to the log on the instrument according to the selected measurement interval and
date range. All measurements are done at the same time.
The status of the last log made is shown on the Logging window and in the status bar.
Notes:

• The settings of a log can be changed until the first measurement is done.
• A log can be stopped before it is completed. The recorded log measurements are

saved.
• The contents of a log can be transferred to a PC at any time before the log is

completed without stopping the log.
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5.2.1 Make a new log
Note: Only one log file can be made (active) at a time. After the log is completed or stopped,
another log can be made.

1. Click Logging in the navigation bar.
2. Click Create New Log. The last log made must be completed or stopped to make a

new log.
Note: To reuse the log values of a completed log, select the log in the right pane, then click
Copy to New before Create New Log is clicked.

3. Optional: In the Template field, select a log template to add frequently used log
settings and information to the new log.

4. Enter the log settings.

Option Description

Start Date Sets the date and time for the measurements to start.

End Date Sets the date and time for the measurements to stop.

Sensor Warm-
Up Time

Sets the time interval before measurements are done after the instrument
switches on. The instrument switches off or goes into low-power (sleep)
mode between measurements.

Primary
Interval

Sets the time interval between measurements (1 second minimum). Make
sure that the primary interval is longer than the sensor warm-up time.
Note: For deployment with the mooring cap, the time interval affects the
battery life. The longer the time interval the longer the battery life. The life
of a new battery is approximately 75 days of use with a 15-minute logging
interval and a 30-second warm-up time with temperature, conductivity, pH
and LDO sensors installed.

Secondary
Interval

Enables a second time interval between measurements to become active
when the selected parameter(s) (e.g., temperature) is within the selected
range. A maximum of 4 triggers can be selected at one time. The primary
interval becomes inactive when the secondary interval is active.
The secondary interval is typically shorter than the primary interval. Make
sure that the secondary interval is longer than the sensor warm-up time.

5. Optional: Change the default filename for the log in the File Name field.
6. Optional: In the User field, select a user.

Note: To add a new user, select New User in the User field.
7. Optional: In the Office field, select an office.

Note: To add a new office, select New Office in the Office field.
8. Optional: In the Location field, select a location.

Note: To add a new location, select New Location in the Location field.
9. To start the log, click Save Log. The log becomes active. The time remaining before

the first measurement is done shows.

5.2.2 Make a log template (optional)
Make a log template(s) to add frequently used log settings and information to new logs. A
log template can include:

• Sensor warm-up time
• Primary interval
• Secondary interval
• User
• Office
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• Location

1. Click Logging in the navigation bar.
2. Click Create New Log. The last log made must be completed or stopped to make a

new log.
3. With the Template field blank, enter the log settings to be included in the template.
4. Click Save as New and enter a name for the template.
5. To delete a template, select it in the Template field, then click Delete. As an

alternative, select Setup>Delete Templates.

5.2.3 Transfer logs to a PC
Logs must be saved to a PC before they can be viewed, sent to a printer or saved as a
comma-separated value (.csv) text file.

1. Click Logging in the navigation bar. The completed logs are shown in the right pane.
Note: As an alternative, click Overview.

2. Select a log, then click Transfer.
Note: To select more than one log, use the Ctrl or Shift key.

3. Select a folder on the PC, then click Save.

5.3 Look at a log file
Log files are shown in the same tabular and/or graph format as real-time measurements
and depth profile measurements. All the view options that are available in the Monitoring
window are available to change the view of the log file. Refer to Look at real-time
measurements on page 17.
Log files can be sent to a printer or saved as comma-separated (.csv) text files.
Note: Logs must be saved to the PC before they can be opened, sent to a printer or saved as a
comma-separated (.csv) text file. Refer to Transfer logs to a PC on page 25.

1. Select File>Open Log File.
Note: Log files can also be opened from the Device connection window. Refer to Device
connection window on page 5.

2. Select the log file, then click Open.
3. To show an enlargement of a specific area of the graph, click and drag the cursor to

select the area.
4. To print the current view of the log file, click Print Page.
5. To save the log file as a comma-separated (.csv) text file, click Export. Select the

parameters to export and the parameter order.
6. To close the log file, click Close.

Note: As an alternative, select File>Close Log File.
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Section 6 SDI-12 commands

Connect the instrument to the optional SDI-12 communications module for
SDI-12 communications as applicable. Table 4 is a summary of the SDI-12 user
commands supported by the instrument. For more details on use, refer to the
SDI-12 V1.3 specification.
The 'a' used in the SDI-12 commands is the SDI-12 address. The factory default
SDI-12 address of the transmitter is 0.

Table 4  SDI-12 commands

Command Response Description

?! a<crlf> Address query

a! a<crlf> Address acknowledge

aI! aXXHydrolabYYYYYYZZZZserialnumber <crlf> Identify
XX—SDI–12 support version
YYYYYY—Instrument ID
ZZZZ—Software version

aAb! b<crlf> Change the SDI-12 address (0–9)

aM! adddn<crlf> Measure n values in ddd seconds

aDx! aSvalueSvalue...<crlf> Report data

aRx! aSvalueSvalue...<crlf> Report continuous data

aC! adddnn<crlf> Concurrent measure, nn values in ddd seconds

aX1! aX1<crlf> Enable continuous mode

aX0! aX0<crlf> Disable continuous mode
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Section 7 TTY commands

Connect the instrument to the optional RS232 TTY communications module for TTY
communications as applicable. Table 5 is a summary of the TTY user commands
supported by the instrument.
To send a TTY command to the instrument, push the spacebar (or sending an ASCII
space character). The instrument will complete the last line, then send "<cr><lf>" and the
command menu (H, M, ?).
<cr><lf>HM?:<sp>
Enter one of the commands in Table 5 (e.g., <sp>H<cr><lf>). The instrument will send
the same command back if the command is accepted.
Note: If a command is not accepted, an ASCII BEL character is sent back. An ASCII escape
character will abort the menu after a cancel message is shown.

If the TTY menu is not used, a line of data is periodically shown on the next available line.
If the screen is full, the lines are scrolled. All data lines stop with <cr><lf> and have the
same formatting as the (M)easure command.

Table 5  TTY command menu

Command Description Reply Notes

H Show the
instrument ID,
then a header that
identifies the data
fields with the
names and units

<cr><lf>Instrument Id<cr><lf>
<cr><lf><sp><sp>Time<sp><sp><sp>Temp<sp><sp>Ibatt<cr><lf>
HHMMSS<sp><sp><sp><sp><sp>°C<sp><sp>Volts<cr><lf>
First line—Free-field text (maximum of 20 characters in length)
Second line—Skipped and the data names given.
Last line—Corresponding units for the data fields

Data names and units
are right-justified and
5 to 8 characters wide
(6 typical). Any name
can show in any field
when configured in
ANSI mode.

M Force the
instrument to send
one line of data
before the next
data display
interval.1

231302<sp><sp>24.59<sp><sp><sp>12.0<cr><lf> Data values can be
followed by a special
character (*, ~, @, #,
or ?). Data values with
an appended character
may not have a space
separator.
Data values are right-
justified and 5 to
8 characters. Data
values are adjusted as
necessary to fit in the
width field (##.##). The
sign and decimal point
are kept.

? Show the detailed
command menu

<cr><lf>Main Menu<cr><lf>
(H)eader<cr><lf>
(M)easure<cr><lf>
(Q)uit TTY Mode<cr><lf>
Please enter your choice:<sp>

Q or q Quit TTY mode
and set the
instrument to full
terminal mode

Enter Q before the
instrument is
connected to the
Hydrolab Operating
Software.

1 Use this command to synchronize the data acquisition software with the instrument data output.
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Section 8 Troubleshooting

Contact technical support if the troubleshooting steps that follow do not correct the
problem.

Problem Possible cause Solution

Not able to connect to the
instrument

The software driver for the
communications module has not been
installed on the USB port.
Note: If a different USB port is used on a PC,
the software driver for the communications
module must be installed again.

Do the initial installation steps in Connect to a PC of
the sonde user manual.

A cable is faulty. Replace the cables one at a time to identify the faulty
cable. Replace the faulty cable.

No power is supplied to the instrument. Make sure that sufficient power is supplied to the
communications module. Refer to Specifications in
the sonde user manual for power requirements.
If the instrument has the internal battery pack option,
replace the battery. Refer to Replace the battery in
the sonde user manual.

Instrument disconnects
from software

The battery level is low. Replace the battery. Refer to Replace the battery in
the sonde user manual.

The AC power adapter is not connected to
power and/or the communications
module.

Connect the AC power adapter to a power source
and the communications module.

Slow stabilization time or
inaccurate readings

The sensor is contaminated or damaged. Do sensor maintenance. Refer to the sensor user
manual.

The measurement value is outside the
range of the sensor.

Make sure that the water is within the range of the
sensor.

The reference sensor is not operating
correctly.1

Do sensor maintenance. Refer to the sensor user
manual.

Calibration failed Refer to the instructions shown in the Calibration window.

1 Not all instruments include a reference sensor.

31



Troubleshooting

32





Hach Hydromet
5600 Lindbergh Drive
Loveland, CO 80538 U.S.A.
Tel. (970) 669-3050
(800) 949-3766 (U.S.A. only)
Fax (970) 461-3921
sales@hachhydromet.com
www.hachhydromet.com

OTT Hydromet
Ludwigstrasse 16
87437 Kempten, Germany
Tel. +49 (0)8 31 5617-0
Fax +49 (0)8 31 5617-209
info@ott.com
www.ott.com

© Hach Hydromet, 2013. All rights reserved. Printed in U.S.A. 


	Table of Contents
	Section 1 Product overview
	Section 2 User interface and navigation
	2.1 Device connection window
	2.2 Status bar
	2.3 Navigation bar

	Section 3 Configuration
	3.1 Software settings
	3.1.1 Select the language and calibration mode
	3.1.2 Select the measurement units for calibration
	3.1.3 Add or remove users, locations and offices
	3.1.4 Select the stability check settings
	3.1.5 Copy the software settings to another PC (optional)

	3.2 Instrument settings
	3.2.1 Configure the date, time and sounds
	3.2.2 Install firmware updates
	3.2.3 Configure the security settings
	3.2.4 Change the security password
	3.2.5 Enter the external dependencies

	3.3 Sensor settings
	3.3.1 Configure the sensor maintenance alerts
	3.3.2 Configure the sensor settings
	3.3.2.1 Hydrolab fresh
	3.3.2.2 Hydrolab salt
	3.3.2.3 Standard Methods 2510
	3.3.2.4 DIN EN 27888
	3.3.2.5 Custom


	3.4 Communications module settings
	3.4.1 Configure the SDI-12 communications module
	3.4.2 Configure the RS232 or RS485 Modbus communications module
	3.4.3 Configure the RS232 TTY communications module


	Section 4 Calibration
	4.1 Calibrate the sensors
	4.2 Do a sensor calibration check
	4.3 Look at the calibration history

	Section 5 Operation
	5.1 Monitoring
	5.1.1 Real-time monitoring
	5.1.1.1 Look at real-time measurements
	5.1.1.2 Capture and save real-time measurements

	5.1.2 Depth profile monitoring
	5.1.2.1 Make a new depth profile
	5.1.2.2 Look at depth profile measurements
	5.1.2.3 Capture and save depth profile measurements


	5.2 Logging
	5.2.1 Make a new log
	5.2.2 Make a log template (optional)
	5.2.3 Transfer logs to a PC

	5.3 Look at a log file

	Section 6 SDI-12 commands
	Section 7 TTY commands
	Section 8 Troubleshooting

